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Welcome to the CoDeSys training module for the DCS800, ABB DC Drives.

If you need help navigating this module, please click the Help button in the top right-hand corner. To view
the presenter notes as text, please click the Notes button in the bottom right corner.



Objectives

After completing this module, you will be able to
m Create a small program

= Document an application
m Set the task configuration

m Download a program into the drive
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Help

After completing this module, you will be able to
understand the basics of the CoDeSys programming tool,
create small applications,

document your applications for better understanding,
download a program into the drive,

evaluate the risks for each application.




Help

Exercise 1: Digital signals

m Read two digital inputs (DI's)
m The signals are processed with an AND operator
m The result is written to a digital output (DO)

R

hlock2

hlock1
@
j AND DigOut

hDOut

wChanneI
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Let’s start with the first example. It is a small program with three blocks which should handle
the digital inputs and outputs of the drive. Two of the function blocks are specifically
designed for DCS800. The first one reads the digital inputs. It is called “Digin”. By using the
“DigOut” block you can set the digital outputs of the drive. The blocks are connected with an
“AND operator” which can be found in the list with all IEC operators.
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Create a new project

m Start CoDeSys
>eg. via _the_Cq_DeSys _icon

] & windows Media Player

z (5 adobe

:\j Documents. = = 2
7= OpenOffice.org 2.0 »
% Settings » @ SAP Front End 14
@ DCSB00 Target Installation »
‘@ Search % B (3 Cobesys sppLCwinNT
@ e (5 soundmax » (3} CoDeSys 5P RTE »
@ WinZip » LB Communication 4
22l Run... [ metwork Associates Qs co ] ) cobesys UserManual v2.3
@ PDFCreator L g‘]
@% Log OFf jan.thoma@de.abb.com... @ PDFCreator Toolbar & -] CoDeSys Visualization ¥2.3
o @ CDTools » ¥, versionInfo First Steps with CoDeSys
&) shutoown.. S T — Wy TstallTornet

4, CoDeSys - (Untitled)*

K . ’ﬁ Edit Project Insert Extras Online
i = Create anew project —  EEe—————
. New Frém template...

8 - File > New e
B Close

©
g E Save
8< Save as...
§ g Save/Mail Archive...
H
%‘8‘ Print ‘l l. l.
%é Printer Setup... "l. l'
o s} by
8o

You can start CoDeSys by using a shortcut on the desktop or by finding CoDeSys in the
start-menu. After CoDeSys has started up the last program edited will open automatically.
To create a new application, click on “New” in the ,File* menu.
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Select target

= Select target
9 Select DCSSOO Configuration: INone :] | oK I
and click OK

m The Target Settings of the DCS800 are correct and there
is no need to modify them
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Select the DCS800 as target to get the correct settings between the drive processor and the
software tool. If other PLCs are available, you can see them in the pull-down-menu, for
example the “AC500”, and so on. The target file includes information about the
communication channel and memory functions of the DCS800. For the DCS800 a serial
communication between the PC and the drive is required.

Note, programs can be simulated by using the target setting “None”. The special function
blocks for the DCS800 cannot be simulated with the system.
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Build a PLC_PRG in CFC

rewpou
= The name of the o
Name of the new POL: -UK
program cou l(_j__bf.-—--" = e
" Program C
P L C_P R G " Function Block C b
" Function C FBD
(POU = Program Organization Unit) Retum Type: C sFC

BOOL _J o i
& CFC

®m Programming language
- Select CFCand click OK—

(CFC = Continuous Function Chart )

The other programming languages are:
«IL: Instruction List

LD : Ladder Diagram

* FBD : Function Block Diagram

* SFC : Sequential Function Chart

+ST: Structured Text FRIPED
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CoDeSys includes many programming languages. The ,Instruction List” is a text-based
language. Programming in the language ,Ladder Diagram*“ is like a circuit schematic with
symbols. It is often used in America. ,Function Block Diagram“ is a graphic-based language
with different function blocks. ,Sequential Function Chart" is a language which splits the
program process into steps. ,Structured Text"is a text-based language like C-Code or
Pascal. ,Continuous Function Chart" is a free programmable graphic-based language with
function blocks.
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Program window

= Now the first program window is open

4, CoDeSys - DCS800 Appl Example 0-1.pro* - [PLC_PRG {PRG-CFC)]
QFile Edit Project Insert Extras Onlne Window Help

Bls(E| D@ nElR &[el@mE [ < =|o|E|s]mle|m] s

0001|PROGRAM PLC_PRG

S POUs 0002vAR
[ Sl
\The analog input A2 is to be limited with two parameters between -1GG
< ! I
.
e on Keywords , £
g 4

m In CFC comments can be inserted by
- Insert > Comment

Box Ctrl+B
Input Chrl+I
Qutput Chrl+l
Jump Chrl+]
Label Chrl+L
Ctrl+R

Return

Input of bef Ctrl+&
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Good programming style is signalized by perfect documentation. In CoDeSys it is possible to
add comments for each step in the program. A click with the right mouse button in the
“Editor Window” opens the context-menu from which the item ,Comment“ can open the
comment dialog box. In other programming languages this functionality is also available and
should be used to facilitate understanding of the program for others. The last step of project
developmentis to save the project.
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Save project

i 4 CoDeSys - (Untitled)* B
m The project can be saved by [Fe £t Projt nort Exras

9 Flle 9 Save aS x:xfrnmtemplate...

Open...
Close

Save

SavefMail Archis. ..

Print
Printer Setup...

. File name e g Savein:IﬂDESBDDAplecahonExamples _:J = ﬂ( '
, ©.4.

- Type in name and

click Save
B
£
8
£ File name™ . [DCS800 Appl Example 0-1 | Save |
2
ZE Save as type: [CuDeSys Project (*.pra) j Cancel
3 g
- A\ I ED
FRIDID
°8
@0

The next step is to save the project in a program file with the extension “*.pro”. Choose
“Save as...” in the “File” menu, type in a file name for the program and click “Save”. Now the
applicationis saved.

It is recommended to save each project in a separate folder on your PC together with a
description of the functionality for each file. It's also possible to print the complete project.
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Identification
x
m To identify an application it is A ——
important to fill out the Project o, G et g
InfOI'matIOI’l Tite: [DEABE_Appl _ States |

[san Thoma _Lisenseito. |

[Test1_Vers10

m Open Project Information by
- Project - Project Info

= Now fill in the following:
- Title: DEABB_Appl.

This is my fist pogram, Hellowodd] =]

4 mFormation

i Author Your name 01 Firmwareyer 8 -9.99 -
03 Applicame &  DEABB_Appl.
. - Version: Test1_Vers10 ik 2 = 1
5 . o 06 MotiFexType 8 OnBoard
i - Description: Short description 07 MotzFexType B netsed
) 08 Mot1FexSwyer 8 0
- ) i i i . 09 Mat2FexSwyer 8 0
g¢m The fields Title and Version will Sy R
2< . g _
32 be shown in parameter group 4
23 AL ID D
£ MIpmw
o8

Providing a title and specifying a version of the application will allow for easier identification
of the program. The project information will be shown in parameters of group 4. Parameter
4.03 shows the title field and 4.12 the version field. If no application is active, parameter 4.03
will show “No Application”.
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DCS800 library
4, CoDeSys - DCSBO0 Appl Example 0-1.pro - [Library Manager]
1. Select tab Resources “blatal Sleistoisisia) i
Standard n}b 2211.0211.08:30
6.1
/ Reary lecSic ©726.11.021023 26
2 & B Roeary Standard b 2211.0211:083
2. Double click on Library KT 4= osbwromtetivti
B 00 oy SysTaskinfo 810031633} | o | »f
B8 Alaim conbiguraion
Manager , —ie ==
0 '  Jorrwiey § e
3. Select DCS800Iib.lib s fvi 8 ooer
fl:;(:":’:‘;:‘;w” 18] DiveState (FB)
i 2 comsare
() MuDw (F8)
B] PaGet(FB)
4. Existing function blocks 4 —— e
. . gp«w--;\rsl
: of the DCSB800 library 8 ropacin
E el 8] TaskCycle FB)
2
£ nr [0 ]5v]05]
z% () PO D/ Re. « ;
5<
g2 1
aF :
A DI
RpD
o8

All DCS800 interface function blocks can be found in the DCS800 library. It is an external
library which only works together with the DCS800 converter. Please note that the actual
firmware-version of the drive should fit to the version of DCS800 library!

Inside the library you can find function blocks for reading and writing analog and digital
values, event handling and arithmetic calculations. With CoDeSys it is also possible to read
and write parameters with special DCS800 function blocks.

10
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Change back to program window

1. Select tab POU e
« welect ia PECEE e e
 [000IPROGRAM PLC_*

2. Double click on PLC_PRG to
open the program window

page 11
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In CoDeSys the abbreviation “POU” stands for “program organization unit”. All programs,
functions and function blocks can be found in the root directory. By clicking on a program in
the directory you will open that program’s window. The default program name is PLC_PRG.
It is possible to change this name because for the DCS800 it is not necessary to have a
main program.

11
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Insert function blocks

2 CoDeSys - DCSB00 Appl Example 0-1.pro* - [PLC_PRG (PRG-CFC)]
@) Fie Edt Project Insert Extras Onne Window Help

m  Select the Box icon

m  Drag the Box into the Editor window. The inserted
box is always an AND - operator

page 12
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To insert a function block, please select the icon “box” in the menu. Now the box can be
placed in the editor window. On the right side of each box, you will find a number. This
number gives you information about the execution order of the function blocks. In a network
of many function blocks it is necessary to check the correct execution order. An exampleis a
multiplication of two variables. A multiplication should not be performed until both variables
are updated. Otherwise, the calculation would be inaccurate.

12
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Select the desired function

m The first function to use is a Digin —_

(DCS800 library)
- Mark AND by clicking on it

— |
— {7

m  Get Digin
- Press F2 on the keyboard and select Standard Function blocks

Input assistant

{3 Standard Function Blocks - R

Standard Functions
User defined Functions
Standard Function Blocks
User defined Function Bloc
FBD Operators
Standard Programs
User defined Programs
Conygrsiontperato

m  Select Digin
- Select Digin, click
OK then press Enter
() on the keyboard

DriveState (FB)
wventlnit (FB)
ventSet [FP1
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After a new block is inserted, the “block type” must be changed. To do this, select the type
and press the F2 button. A new window with a list of all available operators and libraries with
the several function blocks will open. In the menu “Standard Function Blocks” you can find
the available function blocks of the several libraries. The menu “FBD Operators” includes all
IEC functions like AND, OR, MUL and so on.

13
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Select and insert further functions

® In the same way insert an AND and a DigOut block

2729
2 1
AND @ DigOut @
hDOut
—wChannel

o

Digln

=

=

=)
I
|

=
=}
=}
T T T T T T 71T

=
=]
T

=3
=}
o

T

The signal direction should be
from the left to the right side!
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Two further function blocks are needed for this application program. The next step is to place
an "AND” operator and a “DigOut” function block to the correct position in the editor window.
In the programming language “continuous function chart” boxes can be adjusted freely in the
editor window. Note that the numbers on the upper right side of the boxes show the
execution order of the blocks. Normally the execution order should be from left to right
according to the signal direction.

14
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Declare function blocks

m Click on the three question marks

m Type in a name (Attention: no spaces allowed!) for the

block, then press Enter () on the keyboard \
X
Class Name Type oK
[var =] [block1 [Digin =l
Symbol list Initial Value Address ﬂ]
et vl || 11} I™ CONSTANT

Comment: | I~ RETAIN

m A pop-up window opens

m Click OK and the name will be saved

page 15

m Declare the block DigOut the same way
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Each function block should be named for identification purposes. This name is called
“Instance”. Click on the question marks on the function block and specify a name. A new
window opens and shows the name of the block and the used type. By clicking “OK” the
settings will be saved, and the name will be shown in the declaration window. These steps
are required to use any function block. Operators and functions don't get a declaration.

15
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Connect function blocks

m  Wires connect the function blocks
m  Mark the connector

m Press and hold the left mouse button and drag the
output line to another connector

m Release the mouse button

hlock1 @

Digln
(=]
hDI2|
hDI3|
hDI4|

[:bIUCM D
Digin b l AND

=
=}
o
T T T 11T

=
=}
=
T

page 16
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In programming language “CFC” the blocks have to be connected with wires. Click on an
input or output and draw a line to another connecting point. It is not possible to connect
outputs with each other. Note, in other programming languages a connection of inputs and
outputs are drawn automatically.

16



Help

Connect function blocks

m  Use the same method to make up all other connections
between the function blocks

block2

block1
—E —&
Digin j AND DigOut
bDI bDOut
bDI2 —wChannel

T T T T T T T T T
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Connect all necessary function blocks in a similar fashion. The end result should look like
the graphic with the three boxes.

In text-based programming languages like “Structured Text” or “Instruction List” connections
are done with allocations. These connections are invisible but represented by variables!

17
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Insert the input

m Insert the missing input

m  Select the Input icon

\ o|o|8 pa|m|o| =4 %] 8|o|o| x|l

m  Drag the Input into
the Editor window

hlock2

H

: i .
and connect the Input o —owor
@é With the Dlgout - wChannel

e

%;% AL D HD
FAIDID

Now the boxes are connected with each other, but a constant value is needed for the input
“Channel” of function block “DigOut”. The next step is to place an input box. Drag the input
box into the editor window and connect it with the connector of function block “DigOut”.

18
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Declare the input value
m Click on the three question marks

m Type in a number for the Input, then press Enter () on
the keyboard

hlock2
DigOut
bDOut

(wChannel
-J

If the constant 1 is connected with /nput “wChannel",
digital output 1 is selected.

In this example:
1 for DO1

AL IDED
Mpmp
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In this example we define the constant “1” for the “Channel” input. The status of “DOut” will
be written to the selected “Channel”. The result can be found in parameter 7.05!

19
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Task configuration

m Change to tab
4, CoDeSys - DCS800 Appl Example 0-1.pro* - [Task configuration]
resources iM File Edit Project | Insert Extras Online Window Help
B38| 5| ] %]

) B £ Poject Ivet Eatros Ork R :
Taskconfiguration’ . .....3

s8] Di@lednissg [ Reomess | ’
$% Resources s RRSIEH &

Task exec:

-2 Global Variables :

8- ey DCS 00D 22905 03343 R

B0 eary locSic 0°26.11.02 102326

B ey Standard i 2211.02 11083

- Reary SysLibTine °8.10.0317:33

8- ibeasy SysTaskindo i 810,03 16:33
8 Alaim configuation

i

Log
() Paarvates Mansger
{3 PLC Conbgaaion

@ Task conbigestion

S | m  Open the Task configuration

m Open a new task
- Insert = Append Task

page 20
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An important part of the DCS800 is the task configuration. The DSC800 only works in a task
triggered mode. Switch from the main menu to the tab resources and then click on “task
configuration”. Now a new window will be opened. To open a new task, select “Insert” in the
menu bar and choose “Append Task”. This means that a new task will be added. It is
possible to define several tasks for more than one program.

20
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Task configuration

m  Type in a name for this task
(Attention: no spaces allowed!)

R W
s (@ Task configurati -
@ Task configuration j Taskdlvbu\e:'
& NewTask }
Name: [MainT ask
Priotity(0..31): 1
Type
p

@ tiggered by extemal event

m Declare the Event
- Open the pull down menu and selecte.g. 5 ms cycle

page 21

Priority isn’t supported! "HH;
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In the “task attributes” you will find several settings to configure the task cycle. The next step
is to define a name for the task setting. All tasks are externally triggered events from the
DCS800. Only the task cycle can be selected! It’s possible to choose time cycles between 5
and 1000 milliseconds. Now one task is defined and can be used to trigger programs.

21
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Task configuration

m Connect a task
- Insert = Append Program Call

¥ configuration
b giMainTask

i _emem
* - (@4 Task configuration il

: Program Call I
B & MainTask

m O p e n th e e e Progem Cat 0 — |_RJ
Input assistant

Input assistant _X_i;

w aUserdelinedegrams 0K I E
Cancel I :

¢ = Select the program

e =

£ - PLC _PRGand click OK

2 A DI

7 Mpmw

The next step is to add a program to the task configuration. This can be done by selecting
“Append Program Call” in the “Insert” menu. After doing so a new window will be opened.
You can add a program call to a task by using the input assistant. In this case there is only
one program existing, so it has to be selected.

22
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Communication parameters

m  Set communication
- Online - Communication Parameters. ..

Communication Parameters S x|
’V?:lw';:jalhost' via Tep/lp I I 0K |
= To declare a new channel N
CI iC k On Ne W e Communication Parameters: New Channel ¥ 5"
)"’”’IPE-CDM-B-»DCSSDO /&QI
= Type in a name forthe — | oue G
n ew C h an n el enial AS232 driver

m Click OK to accept

page 23

Don’t select other devices! For DCS800 only »
the serial communication is available. FRIP»
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To set up the connection between the PC and the drive system, the communication
parameters have to be defined. You can find this part in the menu “Online” under
“communication parameters”. If there is no existing communication channel available, click
on “New” and declare the new channel. Type in a name for the new communication channel
and select the device for DCS800, called Serial (RS232) driver. After that, click “OK” to apply
the settings. These settings are saved on the PC for the next exercises.

23
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Communication parameters

m  Set the communication parameters like this:

communicaton Parameters x
Channel
= localhost' via Tepdlp Ise,ial [RS232) I
PC-COMx - DCSB00

Name Value | Comment ﬂl
Port COM1
Baudrate 38400
Parity Odd / NLI
Stop bits -
Motorola byteorder iYes I:% Remove

m Change the port, if COM1 is not used
- double click on COMx to change the COM port

m Change the Baudrate, if applicable
- double click on Baudrate to change the value

m  The Stop bits = 1 and Motorola byteorder = Yes
Click OK to apply the settings

© Copyright 1/22/2008 ABB. All rights reserved
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Select the COM-port that is used for communication. If you don’t have a serial port on your
PC, please use a PCMCIA adapter.

24
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Communication to DCS800

m Connect PC and DCS800 g¥ample 0-1.pro* - [PLC_PRG (PRG-CFC)] %2588

Extras‘\Onﬁne Window Help

m  Start communication with
- Online = Login

m  Attention: the program is only downloaded into
the DCS800 RAM if the Memory Card is used
and DriveWindow Light is offline.

=  Now the program is compiled. If there are no warnings

and no errors it is downloaded into the drive.
’m Window Help

Start program with (B At

! Logout Ctrl

- Online - Run \-I o
Run FS

page 25
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The next step is to connect the PC with the DCS800. In the menu “Online” click on the item
“Log On” and the project will be compiled. After a successful compilation without any errors
and warnings, the code will be downloaded to the DCS800 RAM. Afterwards activate the
application program by clicking “Run”. Note, that the application program isn’'t saved on the
memory card, yet. This have to be done in another step.
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Test program with hardware

m The result of block DigOut is written into DO CtriWord
(7.05). To get the value displayed on digital output 1, set
DO1Index (14.01) = 705 and
DO1BitNo (14.02) =0

8 7 Wgontrol Words

01 MainCtriword [1} 0x0 OxFFFF

02 AuxCtriword 0 0x0 OxFFFF

03 AuxCtrlword2 [1} 0x0 OxFFFF

04 UsedMCw 8 47F 0x0 OXFFFF Sett|ngs for DO‘]

05 DO Ctriword 1 0x0 OxFFFF

06 RFE Ctriword / 2 0x0 OxFFFF
3 Res u It [E714 Digital Outputs
& 01 DOMlgex 705 -9999 9999
£ 02 DO1BitNo 0 i 15
5 03 DOZIndex 0 9999 9999
2
=3 04 DOZBitNo i 0 15
E) 05 DO3Index i -9999 9999
<a 06 DO3BitNo i 0 15
8«
§2
a2
4
25
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Note that the result of function block “DigOut” will be written to the digital output control word
in parameter 7.05. Bit 0 accords to digital output 1 and so on. To avoid writing two sources to
one sink, the control word must be connected to the physical output in group 14. In this
exercise digital output, one is used and that means that bit zero includes the boolean result.

For this exercise we must write “705” in parameter 14.01. In parameter 14.02 must be
written “0” to select bit 0. With this settings, the result of the application program will be sent
to the correct physical output.
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Exercise 2: Analog signals

m Read two Al's
m The signals are processed via a SUB

® The result is written to an AO

block2
AnOut

hlock1 [: [:
Anin D suB 2 wChanneI
:::1 Out
IAI3—
T iAld—
5 iAIS—
£ iAl6|—
£ iAITacH
=
B4
8%
8«
83
8g
2% A DD
FRIDID
S8
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The second exercise is a combination of two analog signals of the drive’s analog inputs.
Function block “AniIn”, is a shortcut for “read analog inputs” It transfers the voltage at the
analog inputs to an integer value which accords to the scaling of the drive. In this exercise,
the value of analog input one should be subtracted from the value of analog input 2. The
result is written to analog output 1 of the drive. This functionality gives the function block
“AnOut” which characterizes the write to analog output function.

27
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Steps to build the program

m Create a new project

m Select target

m Builda PLC_PRGin CFC

m Insert function blocks

m Declare and connect the function blocks
m Insert and declare input

m Task configuration

® Build the project

page 28

m Configure the communication parameters

Test program with hardware l‘"l\====
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The steps to create the program are the same as in the last exercise.

The first step is to create a new project. Select the target DCS800 and build the program in
programming language CFC. Insert the function blocks and declare and connect the blocks.
Set the task configuration and configure the communication parameters.

Test the program with the DCS800 hardware if the program has been correctly downloaded.

28
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Test program

m The result of the calculation is written into
CtriwWordAO1 (15.02)

m To get the value displayed on analog output 1, set
IndexAO1 (15.01) = 1502

Setting for connection to the
physical analog output 1 (AO1)

5715 Analog Outputs
i 01 IndexAO1 1502 -9999 9999
! 02 Ctriwordaol 4497 -32767 32767

03 ConvModeAO1 +/-10¥ Bi 1} 4
04 Filtao1 0 ms 1] 10000
, 05 ScaleA01 10000 my [1} 10000

Result from function
block AnOut

page 29
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A function unique to the DCS800 is the output configuration. Function block “AnOut” does
not write directly to the hardware. Mainly because problems can occur if two sources are
written to one sink. To avoid this, the result of the function block will be written to a “control
word”. If you want to connect control word with the physical output, there must be a
connection between the output index and the control word in group 15. This means that in
this exercise the control word “1502” must be written to parameter 15.01.

29
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Summary

Key points of this module

m Learn to create a program with CoDeSys
m Work with digital and analog signals

m Connect the PC with the drive and
download the program

page 30
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In this module you should have learned how to create small programs with the DCS800
Control Builder and how to work with digital and analog signals. Once the program is ready,
you should also know how to connect the PC via “RS232” cable with the drive and how to
download the application.

30
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Additional information

® Links to related information
- 3S-software.com

- DC-Drive-News (Intranet)

m Additional references
- Application Manual (3ADW000199)
- Firmware Manual (3ADW000193)
- Hardware Manual (3ADW000194)
- Training Material

Help
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Glossary

m CoDeSys
Controller Development
System (software tool)

= Memory Card
Flash memory

= DriveWindow Light
Software Tool for
commissioning and
maintenance using AC/DC

= Target
Interface between Drive
and CoDeSys tool

Control Builder
Whole system with
software and hardware

PLC_PRG
Main program which is
used in all applications

POU
Program Organization Unit

Library

It includes function blocks
which are given or
designed by other users

AL IDED
Mpmp
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Audio recording (time in minutes)
Audio synchronization and adaptation (h)

Total:
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the form after each step.
Approval is from ABB!
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